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Primeros pasos con Builder

En este repaso introducimos los conceptos basicos en el uso del Builder. Para
empezar creards una aplicacion desde el menu File->New Application (véase figura):

% C++Builder 6 - Project1 [Built: 20,30 secs]

File Edit Search Yiew Project Bun Component Database Tools Window Help

PR ol | /in32 | Sustem | Data Access | D
Z Open... L% Application

T EAM S Rk @

b E Open Praject. .. Chrl+F11 Data Module
Reopen ¥ 1 Form
= F
n Save Chr+S rame
frwy =H urit
&l save as. . n

:'_.1' Save Project As... [ other...

B.. close

s

2L Close Al

-

L Exit

Una vez hecho, se genera un proyecto nuevo al que Builder le da un nombre por
defecto (véase el nombre ‘Projectl’ en la barra del titulo de la figura anterior).

El nuevo proyecto carga un formulario vacio que tiene el aspecto de una ventana
de Windows (véase siguiente figura):

&4 Form1

11 Modified Insert YWUritt.cpp AUnit1 h ADisgram /

Dicho formulario es un objeto del proyecto. Un proyecto en Builder esta
compuesto por objetos graficos (formularios) que son el interfaz de nuestra aplicacion y
de unidades (bloques en los que se escribird el cddigo). Builder por defecto asigna un
nombre al formulario, en la figura anterior puede verse que el nombre asignado es:
‘Form1’.
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Recuerda que un proyecto es = al formulario (parte visible) + las unidades (el
codigo de la aplicacion). Para cambiar el foco entre estos dos objetos utiliza F12
(pruébalo!).

Cuando el formulario tiene el foco (estd en primer plano) y pulsamos F12, el
formulario pasa al fondo y se muestra en primer plano la unidad del proyecto. En la
siguiente figura puedes ver que el objeto ‘Unit’ tiene el foco y el formulario ‘Form1’
queda en segundo plano justo detrds:

B Unitl.cpp

A Unin cpp - = -
s ~ _l

[#-(a#] Project] - Classes

f#include <vel.h>
#ipragma hdrstop

f#include "Unitl.h™
s
fipragma package [swart_init)
#pragma resource "% dfm”
TForml *Formil:
A
_ fastecall TForml::TForml (TComponent® Owner)
: TForm(Owner) -
{ o |-
; .
s

11 |Modfied  [insen \LUrit1 cpp fUnit.h {Diagram / éI::

Nota: Si en el proyecto hay més de un formulario y accidentalmente has ‘perdido’
alguno, basta con utilizar Shift+F12 para mostrar la lista de formularios asociados al
proyecto actual. Tan s6lo hay que doble clic en View/Forms... y hacer doble clic en el
formulario buscado:

t Run Component Datal J<N0ne> - ‘ & o
g“ g| Standard | Addtional | Win32 | Svstem | Data Access | Data Controls |

h OF 8 A 2w r o &

Tools Window Help

[1 Fomi
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Action ~
ActiveCantrol H
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AlphaBlend |fal
AlphaBlendyal

alse
..|paLefToRight

ij::\i{;h S I 1.1 Modfied Insert | \Writt.cpp AUrit1.h {Diagram / //,
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Eventos

Nuestra aplicacion estard controlada por eventos. Esto quiere decir que su unica
funcidn serd esperar a que suceda algo, por ejemplo una pulsacién de una tecla, un clic
del ratén sobre un botdn, etc y mientras no se dé este caso, el programa se quedard en un
estado ocioso o ‘durmiendo’.

Con esta idea en mente, en la unidad del proyecto tendremos que escribir el codigo
asociado a cada evento (pulsacién de tecla, clic del ratéon, selecciéon de una lista
desplegable, etc...), es decir, todas aquellas que nuestro programa atienda.

Ejemplo: Imagina una aplicacion que hace las funciones de temporizador: Dos botones,
uno de puesta en marcha ‘Run’ y otro de parada ‘Stop’. En este caso nuestro programa
atenderd a dos eventos:

1. Evento 1 =El botén Run ha sido pulsado.
2. Evento 2 2 El botén Stop ha sido pulsado.

Una vez definidos los eventos, hay que escribir el cédigo correspondiente a cada
evento segun la funcionalidad del programa. Resumiendo, el esquema del programa serd
el siguiente:

Arrancamos el
programa
haciendo doble
clic en el icono

Evento 1 = El bot6n Run ha sido pulsado > Cédigo (1)
Evento 2 > El bot6n Stop ha sido pulsado = Cédigo (2)

El programa se
queda en estado
dormido

Se ha pulsado el
botén Run, se
ejecuta el cédigo
(1) asociado

Se ha pulsado el
botén Stop, se
ejecuta el cédigo
(2) asociado

Fijate que el cédigo asociado a cada evento serd diferente en funcién del evento.
En el ejemplo del temporizador, el cédigo asociado al botén ‘Run’ lo pondrd en marcha
y el cédigo asociado al botén ‘Stop’ lo detendra.

De manera general, una aplicacién Builder funcionard de este modo: Definiremos
qué eventos supervisard y escribiremos el cdédigo asociado a cada uno de ellos y
mientras ninguno de los eventos se activen, el programa quedard ‘dormido’ esperando.
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Modos de supervision

En el caso del cronémetro, la aplicacion se comporta de forma pasiva y el usuario
es el unico que puede ‘despertar’ a la aplicacion. El usuario marca el ritmo del cambio
de estados. Pero ;Qué ocurriria si quisiera arrancar y detener automadticamente el
crondmetro con sensores de presencia conectados al puerto usb?

Segtn lo visto, afadiriamos el c6digo necesario para leer el valor del sensor por el
puerto usb y cada vez que el usuario hiciera clic en el botdn, el evento ejecutaria el
cddigo que leeria el sensor y en funcién del estado activaria el cronémetro.

Ocurre que esta solucién tiene un problema, imagina que hay que controlar
continuamente el sensor, cada segundo, por ejemplo. El caso que se plantea es:

- El usuario debera hacer clic cada segundo en un botén para disparar el evento
que lee el sensor y controla el cronémetro...

Por supuesto, la opcién de tener al usuario enganchado al ordenador haciendo clic
en el mismo botén cada segundo, parece, por decirlo del mejor modo, poco eficiente,
[ no te parece?

Para lograr que la aplicacion realice una tarea periddica, necesitamos que se
dispare un evento y Builder dispone del Timer. Este objeto, parecido a una alarma,
permite despertar a la aplicacion cada cierto tiempo y realizar una tarea concreta. El
tiempo serd configurable en ms.

En estos casos podemos decir que la aplicacién tiene un modo de supervision
pasiva porque para realizar una tarea concreta no necesita de la intervencion del usuario.

Unidades del proyecto

Las unidades del proyecto son los bloques donde se escribe el cddigo que se va a
ejecutar cuando se active los eventos (raton, teclado, temporizador...). Para mostrar en
una ventana todas las unidades del proyecto utilizaremos CTRL+F12.

oK

TENZ0l_PIesencia
Cancel

Help

x]

Pl

Mostrar todas las unidades del proyecto 2 CTRL + F12
Mostrar todos los formularios del proyecto = Maytsculas + F12
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Podemos ver la estructura general de un proyecto utilizando el mend View/Project
Manager (Ctrl+Alt+F11):

Project Manager

| Project] .exe ﬂ [Eﬁ

Fath

C:\Archivoz de programatBorland CBuilderBProjects
C:\Archivos de pragramatBarland\CBuilders\Projects
@ Projectl.res C:MArchivos de pragrama‘BarlandhCBuilders\Praojects
@ Projectl.cpp C:MArchivos de programa’BaorlandhCBuilders\Projects
- @ Hnit'l.u:pp C:\archivos de programatBarlandhCBuilders\FProjects

En la ventana anterior podemos ver que el proyecto ‘Projectl’ estd formado por el
programa principal ‘Projectl.cpp’ y la unidad ‘Unitl’ y si hacemos clic en el signo ‘+’
que aparece a la izquierda de la unidad vemos que objetos forman la unidad:

- @ rit1.cpp C:hArchivos de programat\BarlandSCBuilderB, Projects
El Unitl.cpp  C:Mrchivos de programatB orland\CEuilderEProjects
=l Form1 C:hArchivos de programatBarlandSCBulderB, Projects

Puedes ver en la figura anterior que la unidad ‘Unitl.cpp’ esté relacionada con el
formulario ‘Forml’. Esto significa que para cualquier evento asociado con el
formulario, el codigo relacionado se escribira en la unidad “Unitl”.

Ahora echemos un vistazo al c6digo que contiene la unidad ‘Unitl’:

S Unit1.cpp EI@@

) Unitl.cpp | Project].cpp

+ Project! - Classes

#inolude <wvel.hs
#pragma hdrstop

#include "Unitcl.h"
fipracgma package [Smart_init]
fpragma resource "F,dfm"

TForml *Forml:

_ fasteall TForml::TForml (TComponent® Owner)
: TForm(Owner)

Puedes ver la directiva #include <vcl.h> al principio que indica que esta unidad
puede utilizar funciones externas de libreria necesarias para generar aplicaciones bajo
Windows. En proyectos grandes, las funciones se separan por categorias en unidades
diferentes para garantizar una mejor gestion y organizacion. También puedes ver
definida una variable Form1 del tipo *TForm1 necesaria para utilizar el formulario.
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Repasando lo visto hasta ahora, una aplicacién se compone, al menos, de un
archivo de cdédigo con el programa principal y opcionalmente de un conjunto de
modulos adicionales en los que se escriben diversas funciones. Builder utiliza el
programa principal para almacenar el codigo del proyecto que normalmente no sera
visible. Ademas del cédigo del proyecto, cualquier aplicacién contard con al menos un
formulario que tendrd vinculado un médulo de cédigo. Para cada formulario adicional,
existirda un moédulo de cédigo vinculado. También es posible tener otros moddulos
(unidades) no vinculados a ningtin formulario que contendrés otras funciones u objetos
necesarios para la aplicacion.

Archivos de cabecera

Cuando escribimos funciones en una unidad, los nombres de las mismas quedan
registrados en un archivo de cabecera llamado nombre_fichero.h. En términos generales
en los archivos de cabecera quedan definidas todas las funciones que deseamos hacer
publicas y a las que otras unidades tendran acceso.

Por ejemplo para mostrar el archivo de cabecera de la unidad Unitl.cpp, sigue lo pasos:

1. Sitda el cursor en la zona del cédigo de la unidad.
2. Activa el menu contextual = Open Source/Header File (Ctrl+F6)

B Wnit1.cpp

2 Uit g i
e .o | Projectl.
=[] Project] - Classes LIgE R

= ;gl TFom1 Ia ”~
th TForm[TCor #pragwa package [Swart_init)
Functions f#ipragwa resource "%, dfm"

USSR R SourcefHeader File  Ctrl+Fe

4 T Closeage CtrktFa

— : TForm(Ow Open File at Cursar ChrlHEnter

‘ TMew Edit Window

) Topic Search F1

S Add To-Do Ltem... shife+Cerl+T L

Podras ver que en las pestafias de la parte superior del c6digo ahora aparece ‘Unitl.h’ en
vez de ‘Unitl.cpp’. Ahora estés viendo el contenido del archivo de cabecera:

& Unit1.cpp

= Unitt h | proj
———————————— . 1.
=[] Project] - Classes [oiEE LCPD

= ;%] TFarm1 #include <Controls.hpps rS
‘;., TFarmd[TCor #include <StcdCtrls.hpp>
Functions #include <Forms.hpps
£
class TFDrmlI : public TForm
{
__ published: /4 IDE-managed Components
A void _ Ffastcall Buttonlclick(Tobject *Sender):
private: A4 User declarztions
public: A4 User declarztions
_ fastcall TForml(TComponent® Owner);

ri
74
extern PACEAGE TForml *Forml:
74
#endif

Fijate que también puedes cambiar entre el archivo de cabecera ‘Unitl.h’ y la
unidad ‘Unitl.cpp’ utilizando las pestafias mostradas en la parte inferior de la zona de
codigo.
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Todo empieza en el programa principal

Cuando se ejecuta una aplicacion, su punto de entrada es la funcién WinMain que
estd en el programa principal, es decir, en ‘Projectl.cpp’. Vamos a echarle un vistazo:

1. Selecciona el mend View =>Project Manager, veras la siguiente figura:

Project Manager

&l

Mew

>

FRemove

=

Path

| Froject] exe

Filez

= Iig ProjectGroupi

= Project].exe
=] Project! res

C:Mvrchivos de programatB orlandsCBuilders\Projects
C:vrchivos de programatB orlandsCBuilders\Projects
C:Mvarchivos de programatB orlands CBuilders\Projects

C:Marchivoz de programa'B orland W CBuilder6\Projects
C:Marchivoz de programa'B orland W CBuilder6\Projects

@ Project].cpp
+ @ Unit1.cpp

2. Haz doble clic sobre ‘Projectl’
WinMain:

para ver el cédigo del programa principal

S Project1.cpp

Unitl.cpp  Projectl.cpp
£

Ed|
=[] Project] - Classes

= ;y TFarm1

*gu TFom1(TCor
Functions

#include <vcl.h>
#pragma hdrstop
I
USEFORM {"Unitl.cpp”,
I
WINAPT [[FENIERY(HINSTANCE, HINSTANCE, LPSTR, int)
¢

Forml) :

ShowMessage [("Bienvenido al sistema'™):

try

{
Application-»Initialize();
Application->CreateFormi_ classid(TForml],
Application->Runi);

&Forml) ;

Como ejercicio afiade el c6digo necesario para mostrar un mensaje por pantalla en la
funcién WinMain como puede verse en la figura:

- ShowMessage(“Bienvenido al sistema”);

Guardar el proyecto

Es importante que grabes el proyecto nada mds empezar:

Guardar el proyecto y los archivos
File->Save All (Shift+Ctrl+S)

Crear un directorio para el proyecto

Dar nombre a la unidad Unitl
Dar nombre al proyecto Projectl
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Compilar y ejecutar una aplicaciéon

Compilar la aplicacién: Project = Build Project

ODE - | ﬁ @B Add to Project... Shift+F11  fional | Win32 | Svstem | DataAccess | Data Controle | dbEs
FRemovefromProject... = % A Iﬁ K ® m|
71| Tmpark Type Library., ..
EF add ko Repositary...
View Source

[#] Project] - Clazses

Languages 4
;';I IForm1 & Edit Option Souree [T T T T T T T T T T T
F* TtFUII'ﬂ'I (TCon Export Makefile. ..
unctions

\% Add Mew Project..,
E'D‘ &dd Existing Project,.,  fTTTTTTTTTT T oo o T oo oo T oo T

I Carpile Unit AlE+FD

%} Make Projectl Ctr4+F3  PANCE, HINSTANCE, LPSITE, int)

=kl I

i Information for Projectl

ido al sistema™):;
@: Make &ll Projects

B Eid all Projects

1ol

Ejecutar la aplicacion: Run > Run (F9)

¢ C++Builder 6, - Projectd

J File Edit Search Wiew Project  Run Component Database Tools  Window  Help “-‘

De- B e% 3. TR v
J@ e E|D J T |<‘_Attacht0Pr0cess... i T

ki Parameters. .,

=] Project1.cpp Fxt register Activex, Server -

x Unitt ﬁ( Unreqister Actives Server
- nitl .
E@] Project] - Classes Install COM+ Objects...

4] TFom1 ANe—————————————— -
: -'-* TFom1{T Cor D" Skep Crwer Fg
=~ N #d E Temmn Teka c=

Cuando ejecutes la aplicacion, verds que se muestra el mensaje que hemos afiadido:

++Builder 6 - Project1 [Running]

File Edit Search “iew Project Run Component Database Tools Wwindow Help “<NUHE>

Standard IAdditinnaI | Win32 | Sustem | DataAccess | DataCol

D | G0 33 &
N L AR EHw R o 5

®ET O > -0 o

& Project1.cpp

EIT
— = nitl. Project].cpp
(=) Praject! - Classes o che |

E|;5| TForm1 g4

gy TFam1(TCor

(@] Funclions #include <vel.h>
#ipragma hdrstop —
L Project1 [ I—
USEFORM ("Unitl.cpp”,
7 Bienvenido &l distema |

+  |WINAPT [EEONEER (HINST

i

PSTR, int)

- FhowMessage ["Bienvenido al sistema™);

Una vez hagas clic en el boton se cargard el formulario vacio.
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Ahora vamos a cambiar algunas propiedades del formulario. Para ver sus
propiedades, primero haz clic en cualquier zona del formulario y fijate en la columna de

la izquierda ‘Object Inspector’. En esa columna aparecen todas

las propiedades que

pueden cambiarse del objeto seleccionado, en este caso, un formulario.

Nota: Sino ves el ‘Object Inspector’ pulsa F11 o el menud Viev/Object Inspector.

File Edit Search View Project Run Component Database Tools Window Help <Mong> ha 9;',

D -d & ﬁ = & Standard ]Addilional] Win32 | Sustem | Datafccess | Data Contrals | dbEx

BREWIO)» -0 h S8 &AW wr 6 S Fa

Oress ] DataSnao ] EBDE

B g

Object Inspector E ,g s

Form1 =

Properties ] Ewents }

AlphaBlend | false A
AlphaBlendyall 255
HAnchors [akLeft.akTop]
AutoScrol trug
AutoSize falze
BiDiMode bdlLeftT oRight
Borderlcons | [biSystembdenu,
BorderStyle | beSizeabls
Bordetwidth |0

Caption de |a aplicacion
ClientHeight | 446
Clienfwidth | £88

Color [ cBtnFace
Constraints [T SizeConstrain

CtizD true

Cursor crDefault

Defaulttdonitor | drmbctiveFarmn s

Al shawn

Puedes ver dos pestafias, ‘Properties’ y ‘Events’. Si quieres cambiar el nombre del
formulario, su tamafio, el color, tipo de bordes, posicion, etc...debes hacerlo desde la
pestafia propiedades. Cuando tengas que definir un comportamiento sobre un objeto
como un clic de ratén, una tecla pulsada, etc debes hacerlo desde eventos.

Modificar las propiedades del formulario

Modificar la propiedad Caption
Modificar la propiedad Name
Modificar la propiedad Color
Modificar la propiedad Width
Modificar la propiedad Height

Ejecutar y ver los cambios
Editar de nuevo

Modificar la propiedad Left
Modificar la propiedad Top
Modificar la propiedad FormStyle a fsStayOnTop (siempre visible)

Ejecutar y ver los cambios
Guardar los cambios
File->Save All (Shift+Ctrl+S)
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Se propone la creacién de un sencillo temporizador. Situards dos botones en el
formulario, uno para ponerlo en marcha: ‘Start’ y otro para detenerlo: ‘Stop’. Se
mostrard en un cuadro de texto el tiempo transcurrido en milisegundos.

=¥ Inicio de la aplicacion

Se utilizard un temporizador y el sistema tendrd tres eventos, clic sobre el botén
‘Start’, clic sobre el botén ‘Stop’ y el evento del Timer que refrescard el cuadro de
texto. Dibujar un esquema de su funcionamiento.

Ajustar su tamafo, color, posicién y cambiar el nombre por defecto utilizando el
inspector de propiedades.
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